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  About this Manual

  Purpose
This system guide aims to give you all the information you need to know about
RDM.

  Manual Structure
This user’s guide consists of five  chapters and three appendices.

  Chapter  1 Overview

This chapter contains a brief introduction about RDM and the special features that
it offers.

  Chapter 2 RDM Installation

This chapter describes how to install the RDM components and peripherals, agent
driver and station software.  It also tells how to create a hidden partition.

  Chapter 3 Setting Up RDM-Enabled Servers

This chapter describes how to set up and configure a server to be monitored by
RDM, including setting the RDM BIOS and its parameters.

  Chapter 4 Using RDM Station

This chapter discusses how to use RDM under different operation modes and how
to use the RDM Station software.
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  Chapter 5 Troubleshooting

This chapter gives tips and countermeasures for some common problems, and lists
the BIOS messages that you may encounter during RDM operation.

  Appendix A RDM Module Test Utilities

This appendix gives instructions on how to run the RDM module test utilities to
verify  if the module is working properly.

  Appendix B SCO OpenServer and the RDM Partition

This appendix describes how install RDM on a SCO OpenServer operating system.

  Appendix C Snapshot Window Information

This appendix describes the contents of the Snapshot window.

  How to Use the Manual
Before you install the product, read Chapters 1 (Overview) and 2 (RDM
Installation).  Follow the installation instructions in Chapter 2 accordingly.  After
installing, read Chapters 3 and 4 for detailed information on RDM’s capabilities.
In case you encounter some problems during RDM operation, refer to Chapter 5
(Troubleshooting) for tips and countermeasures.  Appendices A, B, and C serve as
references.
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  Conventions
The following are the conventions used in this manual:

Text entered by user Represents text input by the user.
Screen messages Denotes actual messages that

appear onscreen.

, , , etc. Represent the actual keys that you
have to press on the keyboard.

NOTE
Gives bits and pieces of additional
information related to the current
topic.

WARNING
Alerts you to any damage that
might result from doing or not
doing specific actions.

CAUTION
Gives precautionary measures to
avoid possible hardware or
software problems.

IMPORTANT
Reminds you to do specific actions
relevant to the accomplishment of
procedures.

TIP
Tells how to accomplish a
procedure with minimum steps
through little shortcuts.
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  Glossary of Terms
The following terms are used throughout this manual:

Heartbeat

RDM’s method of obtaining data from monitored servers.  The server sends a
heartbeat signal to the RDM module at defined intervals.  In the event of a
server failure, server stops sending heartbeat signal to the RDM module, then
allows RDM to take control of the system.

Hidden partition

A DOS partition on the local system hard disk drive that allows you to install
any system utilities.  To access the system utilities in the hidden partition, you
must enable the Hidden Partition parameter in the RDM BIOS Setup.  When
enabled, the system boots to hidden partition.  For more details on RDM BIOS,
see Chapter 3.

POST

Power On Self Test

Password

A case-sensitive, alphanumeric string consisting of 3 to 16 characters used by
both RDM Station and server to make connection and to prevent unauthorized
access to the server.

RDM agent

A server system that is monitored by the RDM Station.  Throughout this
manual, the terms agent and server are used interchangeably.
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RDM BIOS

A BIOS menu that contains the RDM configuration settings, such as pager
phone number, communication settings, and password.

RDM driver

Software required in order to operate in RDM Runtime Remote mode.  The
RDM driver is loaded as part of the ASM agent installation.  For instructions
on installing the ASM agent software, refer to the ASM Pro user’s guide.

RDM host

Also refers to RDM agent.

RDM LED indicator

A front-panel indicator displaying the RDM status.  The RDM LED indicator
remains lit whenever RDM is activated in Runtime Remote mode.  See Chapter
2 for details.

RDM module

A daughter board that functions as an RDM controller.  This board must be
installed on your server.  The RDM module contains a microprocessor and
firmware.

RDM Station

A client system used locally to monitor a remote server.  Throughout this
manual, the terms station and client are used interchangeably.
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Chapter 1  Overview
Remote Diagnostic Manager (RDM) is a server service module that allows server
management control via remote station.  It utilizes modems, pagers, and telephone
lines to let a remote station to monitor and analyze the server condition, update
system BIOS settings and quickly restore the system to normal operation.  This
“quick response” feature of RDM minimizes the time wasted due to system failure
and therefore, offers the best solution for the distance barrier issue.

The following figure shows an example of a typical RDM configuration:

Figure 1-1 Typical RDM Configuration
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  1.1 Features
The following features prove that RDM offers the most efficient and practical
server diagnostic service.

  1.1.1 System Failure Detection Features

• Allows the system to boot from the RDM partition for access to diagnostic
utilities

• Offers diagnostic service, eliminating the distance barrier for remote consoles

• Informs the system administrator once the server hangs

• Allows automatic system reboot once failure is detected

• RDM drivers support Novell NetWare, Microsoft Windows NT, and SCO
OpenServer

  1.1.2 Remote Console Features

• Monitors the system boot sequence

• Allows remote site to update the system BIOS or change the CMOS setup

• Allows the system to boot normally or boot to the RDM partition

• Allows remote access to the server’s diagnostic utilities

• Supports file transfer
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  1.1.3 New Features in RDM v3.01

• Monitors and displays server status information (such as system part number,
health log, critical event, CPU information, temperature, voltage, fuse, CPU
critical event, power supply, etc.) and configuration, even in the event of
server failure

• Can power on/off the server from remote site

• Smart reboot feature allowing the server to boot from any available processor

• Automatic system power off in case of system failure and/or processor
temperature exceeds the maximum limit

• BIOS supports ANSI terminal, allowing the station to display the RDM host
screen after connection is established

• Features the Talk utility that allows users at both agent and remote sites to
communicate easily
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  1.2 Architecture
RDM consists of three main components:

• RDM agent

• RDM Station

• RDM connectivity

Figure 1-2 shows the RDM block diagram.

Figure 1-2 RDM Block Diagram

Heartbeat
signal

RDM
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During normal operation, the RDM driver periodically sends a hearbeat signal to
the RDM module.  Once the agent fails, the RDM driver stops sending heartbeat
signal to the RDM module.  If the module processor does not receive any signal for
a certain period of time, the RDM LED lights up signaling that RDM is activated.

When RDM is enabled, the module takes control of the COM port occupied by the
modem and functions as the modem controller.  It notifies the system
administrator (through paging) that the server failed.  RDM operates according to
the RDM Work Mode specified in BIOS Setup (refer to Chapter 3).

  1.2.1 RDM Agent

The RDM agent refers to the system with an RDM module.  An RDM module
contains a microprocessor that acts as an RDM controller.  See Chapter 2 for more
details on RDM module.

To enable the RDM module, the RDM agent driver must be installed into the RDM
agent and the system BIOS must include the RDM BIOS.  The RDM BIOS supports
extended functions for initializing the RDM module and establishing connection
between the agent and the RDM Station to enable RDM Station control.  Chapter 2
tells how to install the RDM drivers.  Chapter 3 tells how to configure the RDM
BIOS.

For information on how to configure the system BIOS, see the user’s guide that
came with the system.

  1.2.2 RDM Station

The RDM Station can be any standard PC system with RDM Station software
installed and the necessary peripherals connected.  For details on how to install the
RDM Station software and the necessary peripherals, refer to Chapter 2.
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  1.2.3 RDM Connectivity

This refers to the RDM connection.  For the RDM agent to establish connection
with the RDM Station, it must have the RDM module, LED, and the RDM agent
driver installed into the server.  For the RDM Station, it must have the RDM
Station software.

Peripherals such as modem and pager are necessary for RDM to function properly.
The RDM agent and the RDM Station communicate via modem protocol.  Chapter
2 tells how to connect the necessary peripherals into the system.

Make sure that the modem and other
peripherals are turned on.  Otherwise, the
RDM agent will not be able to establish
connection with the RDM Station.  For
information on how to install a modem, refer
to section 2.2.1.
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Chapter 2  RDM Installation
This chapter gives step-by-step instructions on how to install the RDM module, the
RDM agent and station software.

  Contents of the Distribution

Your software package includes the following:

• ASM Pro software (included on the Acer StartUp CD-ROM)

• RDM Station software (included on the Acer StartUp CD-ROM)

• RDM User’s Guide (this manual)

If anything is missing or damaged, please contact your dealer immediately.

  2.1 System Requirements
Before you begin the installation, make sure that you have the following:

  2.1.1 RDM Agent Requirements

  Hardware

• External modem

• RDM module

• RDM LED indicator

• Pager
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  Software

• Novell NetWare v4.1 or later

• SCO OpenServer 5.0 or later

• Microsoft Windows NT 4.0 or later

• ASM (Advanced Server Manager) driver for RDM agent

  2.1.2 RDM Station Requirements

  Hardware

• Pentium or faster PC

• At least 16-MB RAM

• At least 5-MB free hard disk space

• Modem

  Software

• Microsoft Windows 95, or

• Microsoft NT Workstation 4.0

  2.2 RDM Agent Setup
This section describes how to set up the RDM agent.
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  2.2.1 Hardware Installation

The RDM module and LED are pre-installed
at the Acer factory.  The following RDM
module and LED instructions are provided in
the event that you ever need to reinstall the
RDM module and LED.

For your new system, please go to the
“Connecting Communication Peripherals”
section for information about installing a
modem, telephone, or pager.

  1.  ESD Precautions

Electrostatic discharge (ESD) can damage your processor, disk drives, expansion
boards, and other components.  Always observe the following precautions before
you install a system component.

1. Do not remove a component from its protective packaging until you are ready
to install it.

2. Wear a wrist grounding strap and attach it to a metal part of the system unit
before handling components.  If a wrist strap is not available, maintain contact
with the system unit throughout any procedure requiring ESD protection.

  2.  Pre-installation Instructions

Always observe the following before you install a system component:

1. Turn off the system power and all the peripherals connected to the unit before
opening it.

2. Open the system according to the instructions in the housing installation
manual.
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3. Follow the ESD precautions listed in the previous section before handling a
system component.

4. Remove any expansion boards or peripherals that block access to the desired
system board slot or connectors.

5. See the following sections for specific instructions on the component you wish
to install.

  3.  Installing the RDM Module and LED

The following figure shows the RDM module layout:

1 23-pin connector
2 RDM controller
3 RDM LED connector
4 23-pin connector

Figure 2-1 RDM Module Layout
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Follow these steps to install the RDM module:

1. Before you proceed, check the location of the LEDs on your system housing.
The LEDs may be positioned either:

• vertically aligned at the upper-right corner of the housing front panel.

• horizontally aligned at the center of the housing front panel.

2. Open the system housing.  Refer to your housing documentation for the
instructions.

3. Remove the LEDs.  Refer to your housing documentation for instructions.

Do not forget where the hard disk and power
LED cables are connected.

4. Insert the RDM LED module into the LED slots.

5. Bundle the LED cables with the cable holder provided in the system housing
and insert them into the appropriate slots in the housing.

A.  LEDs located at the upper-right
corner of the housing

B.  LEDs located at the center of the
housing

Figure 2-2 Installing the LEDs
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6. Connect the RDM LED cable (i.e., the cable connected to the center LED) to the
RDM module’s LED connector (i.e., the onboard three-pin connector).  Refer to
Figure 2-1 for the location of the LED connector.

Notice that one-hole of the RDM LED cable
connector is covered.  This ensures the
proper connection.

7. Locate the two 23-pin RDM connectors on the system board.  Refer to the
board layout figure in the system user’s guide.

8. Align the RDM module connectors to their corresponding connectors on the
system board.

9. Gently insert the module.  Make sure not to bend any pins and that the module
is properly seated.

Figure 2-3 Connecting the RDM LED Cable and Installing the RDM Module

LED
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10. Connect the hard disk and power LED cables to their corresponding
connectors on the system board.

Remember where the original LED cables
are previously connected.  You may also
refer to your system board documentation for
the connector locations.

11. Ensure that the LED cables are properly connected, then replace the housing
cover.  Refer to your housing documentation for instructions.

12. Enter BIOS Setup to set the desired RDM Work Mode.  See Chapter 3 for
details.

  4.  Connecting Communication Peripherals

  Modem
The server and the station communicate via modem protocol.  Therefore, you need
to connect an external modem with a baud rate of not less than 28,800 bps to both
systems.  To connect an external modem, simply insert the modem connector to the
appropriate port of the system.

The agent modem must be connected to COM2
port, while the station modem can be connected
to either COM1 or COM2 port.  

Use only modems that are purchased locally to
ensure compatibility with your telephone system.
The modem must have at least 28.8K transfer
rate.
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When the modem is turned ON, the CD/DCD (Carrier Detect/Data Carrier
Detect) signal light on the front panel must be OFF for RDM to function properly.
If this is not the case, refer to the modem’s user’s guide and check the section on
DIP switch for information on how to adjust the CD/DCD light.  If your modem
does not have a DIP switch, then we recommend that you replace it with another
model that supports such switches.

  Telephone
RDM connection cannot be established with modems alone.  You cannot fully take
advantage of the RDM features and the modem functions without telephones.
To connect a telephone to a modem, plug in the telephone connector to the modem
telephone port.  Then, insert the telephone line connector to the modem line port.

  Pager
The pager is necessary for notification purposes only.

  5.  Post-installation Instructions

Observe the following after installing a system component:

1. Make sure that the components are installed according to the step-by-step
instructions in their respective sections.

2. Replace any expansion boards or peripherals that you removed earlier.

3. Replace the system cover.

4. Connect the necessary cables.

5. Turn on the system, then the peripherals connected to it.
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  2.2.2 Software Installation

The RDM hidden partition is pre-installed on
your primary hard disk drive at the Acer
factory.  The following instructions on how to
create an RDM hidden partition are provided
in the event that you need to reinstall your
primary hard disk drive.

For your new system, please go to the
“Installing the Operating System” heading
within this section.

  1.  Creating the Hidden Partition

The RDM hidden partition is a DOS partition on the hard disk that allows you to
run pre-installed diagnostic tools when necessary, without using a diskette or a
CD.  It also allows you to access your system from a remote location.

To install the RDM hidden partition, perform the following steps:

RDM partition creation will destroy all data on
the hard disk due to the requirement that the
RDM hidden partition must be the first partition
on your primary hard disk.  Back up all
important data before creating the RDM hidden
partition.
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To create the RDM hidden partition from scratch:

1. Insert the bootable Acer StartUp CD-ROM in the CD-ROM drive and turn on
your computer.  The following screen appears:

A BOOTABLE CD-ROM IS DETECTED IN YOUR CD-ROM DRIVE...

The boot sections on your bootable CD-ROM are:

0:  DEFAULT ENTRY

1:  Other boot options

Please select one option (0-1), ESC to bypass Bootable CD:

2. Select 1, Other boot options.  The following screen appears next:

The boot entries in the section Other boot options are:

0:  ECU

(1.44M FLOPPY DISKETTE)

 1:  DIAGNOSTICS

 (1.44M FLOPPY DISKETTE)

 2:  RDM PARTITION

 (1.44M FLOPPY DISKETTE)

 Please select one option (0-2), ESC to bypass Bootable CD:
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3. Choose 2, RDM PARTITION.  The partition installation screen appears next:

RDM Partition Installation (Version 3.01)

Copyright 1997 Acer America Corporation.

All rights reserved.

RDM Partition is needed for remotely diagnosing your server.

This installation will be done in two Phases.  You must first

complete Phase 1, which will be followed by an automatic

reboot.  After reboot, you will need to return to the RDM

Installation to complete Phase 2.  Have you already done Phase

1 (Select N if you have not done Phase 1) [Y, N]?

4. Choose N to start Phase 1.  If you have already performed Phase 1, skip to step
8.  The following screen appears after you choose N:

************************* PHASE 1 *************************

Please note that after Phase 1 is complete, machine will

reboot automatically.  Please return to RDM Partition

Installation and continue from Phase 2 by answering Y to the

above question next time.

WARNING!     WARNING!     WARNING!

************************************************************

IMPORTANT: PLEASE BACKUP ALL DATA FROM HARD DISK, SINCE ALL

DATA WILL BE ERASED

If you are not sure, you may choose not to proceed and do this

at a later time.

*************************************************************

WARNING:  Do you want to proceed? [Y, N]?
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5. Choose Y to proceed with Phase 1.

IMPORTANT:  Will destroy all data and create RDM partition.

LAST WARNING:  Do you want to proceed? [Y, N]?

6. Choose Y to proceed.

The hidden partition is created, then the system automatically reboots.

7. After your system reboots, repeat steps 1-3.  The following screen reappears:

RDM Partition Installation (Version 3.01)

Copyright 1997 Acer America Corporation.

All rights reserved.

RDM Partition is needed for remotely diagnosing your server.

This installation will be done in two Phases.  You must first

complete Phase 1, which will be followed by an automatic

reboot.  After reboot, you will need to return to the RDM

Installation to complete Phase 2.  Have you already done Phase

1 (Select N if you have not done Phase 1) [Y, N]?

8. Choose Y.  Phase 2 automatically executes (when an existing RDM hidden
partition is discovered).  You will be prompted to reboot the system after
Phase 2 completes.

  2.  Installing the Operating System

RDM supports the following operating systems:

• Novell NetWare

• Microsoft Windows NT

• SCO OpenServer
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During the operating system installation it is
extremely important not to delete or disturb the
RDM partition (usually indicated as unknown
partition).

For installation instructions, refer to the documentation that came with the OS
package.  For instructions on installing SCO OpenServer, refer to Appendix B, SCO
OpenServer and the RDM Partition.

  3.  Installing the RDM Agent Driver

Before you proceed, make sure that you
have installed the necessary components
and peripherals, both for the server and
station.

The RDM agent driver or the server driver is contained in the Advanced Server
Management (ASM) software package.  Therefore, to install the RDM agent driver,
you need to install the ASM agent software.  For information on how to install the
ASM software, refer to the documentation that comes with the ASM package.

  4.  Enabling/Disabling the Driver

After installing the ASM Agent driver, the system automatically enables the RDM
driver.  You do not need to enable the RDM driver manually unless you have
previously disabled it for some reasons.

We strongly recommend that you do NOT
disable the RDM driver.  If you disable the
RDM driver, RDM Station will not be able to
establish remote access to the server in the
event of system failure.

  NetWare
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To enable the RDM driver in a Netware environment, type:

# LOAD MAGENT

To disable the driver, type:

# UNLOAD MAGENT

  

  Windows NT
To enable the RDM driver in a Windows NT environment, open a command
prompt and type:

STARTRDM.EXE

To disable the RDM driver, open a command prompt and type:

CANCEL.EXE

  SCO OpenServer

To enable the RDM drivers in an SCO OpenServer environment, type:

#/XSNMPD/RDMTEST START

where #/XSNMPD is the directory that contains the RDM
drivers.

To disable, type:

#/XSNMPD/RDMTEST CANCEL
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  2.3 RDM Station Setup
This section describes how to install and uninstall the RDM Station software.

  2.3.1 Installing the RDM Station Software

Before you proceed, make sure that you
have installed the necessary components
and peripherals, for both the server and
station.

The RDM v3.01 station software can be
installed only under Windows NT 4.0 or
Windows 95.  The software is compatible
with any version of RDM agent drivers (e.g.,
v1.3, v3.0, and v3.01).

The RDM package comes with a separate diskette that contains the RDM Station
software.

Follow these steps to install the RDM Station software:

1. Turn on the system.

2. Turn on the peripherals connected to the system such as monitor, modem, etc.

3. Insert the RDM Station utility diskette into the diskette drive.

4. Enter the diskette drive directory.

5. Run the utility installation program, i.e., SETUP.EXE.  The Setup Program
Welcome screen appears.
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Figure 2-4 Setup Program Welcome Screen

6. Click on Next.  The Software License Agreement screen appears:

Figure 2-5 Software License Agreement Screen

7. Click on Yes to proceed.  The User Information dialog box appears next.
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Figure 2-6 User Information Dialog Box

8. Enter your name or the user’s name in the Name text box and your company
in the Company text box, then click on Next.  The Registration Confirmation
dialog box appears.

Figure 2-7 Registration Confirmation Dialog Box

9. Check the registration information specified.  If the information is correct, click
on Yes.  If incorrect, click on No to return to the User Information dialog box.
Check your entries and make changes, if necessary.
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10. When the Choose Destination Location dialog box appears, check the specified
location in the Destination Directory box.  If you want to accept the default
location, click on Next.

Figure 2-8 Choose Destination Location Dialog Box

If not, click on Browse and enter the desired location where you want the
setup program to copy the necessary files.

11. In the Select Program Folder dialog box, specify the desired program folder for
the RDM Station software.  Then click on Next to proceed with the installation.
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Figure 2-9 Select Program Folder Dialog Box.

12. After you click on Next, the installation program starts copying the files.
When installation is completed, the following message box appears:

Figure 2-10 Setup Finished Message Box
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13. Do either of the following:

• Click on I would like to view the README file checkbox if you wish to
read the README file after you exit the installation program.

• Click on I would like to launch the RDM Station now checkbox if you wish
to run the RDM Station program immediately after you exit the installation
program.

14. After you have made your selection, click on Finish to complete the
installation and exit the installation program.

  2.3.2 Uninstalling the RDM Station Software

To uninstall RDM Station software, follow these steps:

1. From Windows 95, select Control Panel, then double-click on Add/Remove
Programs.

2. Select RDM Station and click on the Add/Remove button.

3. When prompted to confirm the uninstallation, click on Yes.  The following
screen appears during the uninstallation process.
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Figure 2-11 Remove Programs From Your Computer Message Box

4. When the uninstallation is completed, click on OK.
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Chapter 3  Setting Up RDM-Enabled
Servers

This chapter describes different RDM operation modes.  It also explains the RDM
BIOS features and how to configure RDM functions via the RDM BIOS.

3.1 Operation Modes
The RDM monitored servers run in three different modes:

• Local mode

• Remote mode

• Runtime mode

3.1.1 Local Mode

In Local mode, the server boots to the hidden partition.  This allows you to run
diagnostics and other test programs.  However, in this mode, there is no remote
connection.  Thus, all RDM features are available only to the server.

This mode is useful only if you are located at the physical location of the server.



RDM User’s Guide3-2

3.1.2 Remote Mode

In this mode, the system boots to the hidden partition and automatically
establishes remote connection after reboot.  This makes all RDM features available
to both the server and station sites.  You can run any RDM utilities from a remote
location.  However, this requires operator intervention since Remote mode can
only be activated locally through the server BIOS Setup.

3.1.3 Runtime Mode

The Runtime mode is the normal RDM operation mode.  In this mode, the system
operates under its installed operating system.  In the event of system failure, the
driver stops sending heartbeat signal to the RDM module.  The RDM module then
takes over the COM port and dials the pager number(s) specified in the Remote
Diagnostic Configuration menu.

There are two types of Runtime mode operations:

• Runtime Reboot Mode (Smart Reboot)

• Runtime Remote Mode (Waiting Mode)

3.2 RDM BIOS
This section explains how to configure the RDM function via RDM BIOS.   The
settings entered in the RDM BIOS determine how RDM handles a server failure.
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3.2.1 Entering the RDM BIOS

To enter the RDM BIOS, press    to enter the BIOS Setup utility.
Highlight the Remote Diagnostic Configuration option and press .  Page one
of the menu appears on screen.  This page is for configuring the Remote Console
function.

Remote Diagnostic Configuration Page 1/2

Remote Console ...................[Enabled ]

Hidden Partition .................[Enabled ]

Communication Protocol ...........[N, 8, 1]
COM Port Baud Rate ...............[57600  ] BPS
Telephone Type ...................[Tone   ]
   Detect Tone ...................[Enabled ]

Remote Console Phone NO.: ........[                   ]
Dial Out Retry Times .............[  2  ]

Modem Initial Command ...........[                   ]

↑↓  = Move Highlight Bar,   → ← = Change Setting
PgDn/PgUp = Move Screen,   F1 = Help,   Esc  =  Exit

Press  to view page two of the Remote Diagnostic Configuration menu.  This
page is for configuring the RDM module function.
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Remote Diagnostic Configuration Page 2/2

RDM Work Mode -----------------[Waiting ]
Waiting Mode Password ---------[        1234]

System Critical Paging NO.:
        1.  [123456789,,,,,,#8823940#                ]
        2.  [847982493,,,,,,#3442442#                ]
        3.  [                                        ]
Paging Times ------------------[  1  ]

RDM SEEPROM Verification ------[Enabled ]

↑↓  = Move Highlight Bar, Esc  =  Exit
Number Input, Letter Input, Symbol Input: * , - & % \ #

After entering all the necessary settings, press  to exit the RDM BIOS setup.

3.2.2 Remote Console

This parameter lets you enable or disable the RDM connection.  If enabled, the
server automatically dials the RDM Station phone number specified in the Remote
Console Phone No. parameter (see section 3.2.7) once the server boots.  Once
connection is established, both the server and station sites display the same screen
and enables the station keyboard to function as the main console.  Setting this to
Disabled deactivates the remote console.

 3.2.3 Hidden Partition

If you want the hidden partition to become accessible, set this parameter to
Enabled..  When enabled, the server boots to the hidden partition.

To disable the hidden partition and return to the normal booting procedure, set
this parameter to Disabled.
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We recommend that you set this parameter
to Enabled especially if you are
troubleshooting system problems.

3.2.4 Communication Protocol

This parameter specifies the parity, stop bit, and data length for the COM port
occupied by the modem.  This is fixed at N (none), 8, 1 setting and is non-
configurable.

3.2.5 COM Port Baud Rate

This parameter lets you set the transfer rate of the COM port assigned to the
modem.  The parameter setting depends on your modem specification; therefore,
before you change the setting of this parameter, check your modem
documentation.

Check your System Security Configuration
settings in the BIOS Setup and make sure that
you have assigned a port to serial 2.  Otherwise,
RDM will not function.

3.2.6 Telephone Type

Telephone types vary for every country or area.  Though the Tone type is the most
common, there are still other areas that use the Pulse type.  Check your telephone
type before resetting this parameter.
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Detect Tone

This parameter becomes configurable only if the Telephone Type parameter is set
to Tone.  When enabled, RDM checks for the existence of telephone tone first
before it dials out.  When disabled, RDM proceeds with the dialing process
without checking the telephone tone.

We recommend that you leave this
parameter to its default setting, i.e., Enabled.

3.2.7 Remote Console Phone Number

This parameter allows you to set the station number the RDM module must dial
once RDM is activated and the Remote Console parameter is enabled.  To set,
simply highlight the parameter and enter the station phone number.

Remote Console Phone NO...............[5455299            ]

If the remote connection phone number is utilizing Private Branch eXchange1 (PBX)
line, then you must enter six commas (,) after the phone number and before the
extension number, if any.  When entering the extension number, we recommend
that you insert a comma after each number.  The commas specify delay.

Remote Console Phone NO...............[5455299,,,,,,6,6,4,9]

Leave the parameter blank to disregard the function.
                                                          
1 A PBX is a telephone switching system that requires manual operation to get an outside line.  This

is synonymous to PABX - Private Automatic Branch eXchanges.

    RDM station number

  Extension Number

         Delay



Chapter 3 - Setting Up RDM-Enabled Servers 3-7

3.2.8 Dial Out Retry Times

This parameter lets you specify the maximum number of times the server must
retry connection to the station once server fails and RDM is activated.  If the server
has completed the specified number retrials and connection still fails, the server
bypasses RDM and goes into normal mode.

3.2.9 Modem Initial Command

Some modems require specific commands for initialization.  This parameter allows
you to specify the required command to enable your system to support special
types of modems.  If you do not specify any command, BIOS uses the default
method to initialize the modem.

Specify an initialization command only when
you receive a Modem Initial Command Fail
error message.  Otherwise, leave this
parameter blank.

3.2.10 RDM Work Mode

Before you set this parameter, make sure
that you have an RDM module.  Otherwise,
you cannot set this parameter.

This parameter lets you specify the RDM work mode or the notification procedure.
The mode options are listed in the following table:
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Table 3-1 RDM Work Modes

Mode Description

Waiting
(Runtime
Remote mode)

Once RDM is activated, the server dials the pager
number(s) specified in the System Critical Paging
No. parameters (see section 3.2.12) and waits for
the station to call in.  When the station calls in
with the specified phone number and password,
the Snapshot window (see Figure 4-8)
automatically appears on the station screen.

Reboot Once RDM is activated, the server dials the pager
number(s) specified in the System Critical Paging
No. parameters (see section 3.2.12) and
automatically reboots the system to its original
operating system.

Disabled Deactivates RDM.

Once the server hangs, the RDM LED
automatically lights. 

3.2.11 Waiting Mode Password

This parameter prevents unauthorized access of the server.  To set a password,
simply highlight the parameter and enter your code.  Your password may contain
at least three characters but not more than eight alphanumeric characters (i.e., the
26 letters of the alphabet plus the numbers 0-9).  You cannot use special characters.

Make sure to remember your password.  Before the server grants access to the
station, you will be prompted to enter this password.

You must set a password; otherwise, the server
will not establish connection with the station.
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3.2.12 System Critical Paging Numbers

These parameters allow you to set the pager number that the RDM module must
dial once the server fails or hangs.  To enter the pager number, simply highlight 1,
2 or 3.  Type in the pager number followed by commas (,).  The commas specify the
delay.  The number of commas to enter varies for every country depending on the
communication switch used.  Make sure that you enter the appropriate number of
commas; otherwise, the pager may not receive the complete message.  You can use
any modem utility to determine the number of commas to enter.  For example, to
determine the number of commas via Windows Terminal:

1. Initialize the COM port assigned for the modem function.

2. Enter the system administrator’s pager number (for example:
54555499,,,,#XXXX#).  The default is four commas (,,,,).  If paging is successful,
that means that the number of commas entered is enough.  If not, add one
comma to your entry.  Repeat the procedure until paging is successful.

You may also include the server modem number or the message that you want to
send in the pager notification.  To do this, simply enter a # sign after the commas.
Then enter your message.  At the end of the message, type another # sign.  The
message entry must start and end with # sign.

To bypass this feature, do not enter any number after the comma signs.

System Critical Paging NO.
        1.  [123456789,,,,,,#8823940#              ]
        2.  [847982493,,,,,,#3442442#              ]
        3.  [                                      ]

Leave the parameter blank to disregard the function.

  Pager Number              Message (valid entries: 0-9, * )
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You can enter a maximum of three sets of
pager numbers.  Follow the same procedure
to set the additional pager numbers.

3.2.13 Paging Times

Similar to the Dial Out Retry Times parameter, this parameter lets you specify the
number of times the server must dial the pager number(s) specified in the System
Critical Paging No. parameters (see section 3.2.12) once the server fails and RDM is
activated.

3.2.14 RDM SEEPROM Verification

When set to Enabled, BIOS checks the RDM data stored in the SEEPROM during
system bootup.  To disregard the function, set the parameter to Disabled.

3.3 Setting RDM Operation Modes

3.3.1 RDM Local Mode

In Local mode, the server boots to the hidden partition, allowing you to run
diagnostics and other test programs.

Enabling Local Mode

Follow these steps to enable the Local mode:

1. Reboot the server and enter the BIOS Setup.

2. From the main menu, select Remote Diagnostic Configuration.
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3. Set the Hidden Partition parameter to Enabled.

4. Save your changes and exit the BIOS Setup.  The server automatically reboots.

Exiting from Local Mode

After running the diagnostics, you may now resume the system to normal
operation.  To do this, you need to exit from Local mode.

To exit from Local mode, do the following steps:

1. Reboot the server and enter the BIOS Setup.

2. From the main menu, select the Remote Diagnostic Configuration option.

3. Set the Hidden Partition parameter to Disabled.

4. Save your changes and exit the BIOS Setup.

3.3.2 RDM Remote Mode

In the RDM Remote mode, the system boots to the hidden partition and
automatically establishes remote connection after reboot.  This makes all RDM
features available to both the server and station sites.  You can run any RDM
utilities from a remote location.

Enabling Remote Mode

Follow these steps to enable the Remote mode:

1. Reboot the server and enter the BIOS Setup.

2. From the main menu, select the Remote Diagnostic Configuration option.

3. Set the Remote Console parameter to Enabled.
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4. Set the Dial Out Retry Times parameter to the desired number of times the
server must attempt to call the station to make a connection.

5. In the Remote Console Phone No. parameter, enter the station phone number.

6. Save your changes and exit the BIOS Setup.  The server automatically reboots
and dials the specified station phone number to establish remote connection.

For remotely accessing the server, refer to Chapter 4.

3.3.3 RDM Runtime Mode

The RDM Runtime mode is the normal RDM operation mode.  In this mode, the
system operates under its installed operating system.  In the event of system
failure, the driver stops sending heartbeat signal to the RDM module.  The RDM
module then takes over the COM port and dials the pager number(s) specified in
the Remote Diagnostic Configuration menu.

There are two types of Runtime mode operations:

• Runtime Reboot Mode (Smart Reboot)

• Runtime Remote Mode (Waiting Mode)

The following subsections discuss how each mode operates:

Activating RDM

Make sure that the modems are turned ON
during remote operation.

When the server fails or hangs, the RDM driver stops sending heartbeat signal to
the RDM module.  If the module processor does not receive any heartbeat signal
for a certain period of time, the RDM LED lights up indicating that RDM has been
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activated.  However, if the temperature of any processors in the system exceed its
limit, the RDM module will immediately turn off the system for safety purpose.

When RDM is enabled, the module takes control of the COM port occupied by the
modem and functions as the modem controller.  It notifies the system
administrator (through paging) that the server failed.  RDM operates according to
the RDM Work Mode specified in BIOS Setup (refer to Chapter 3) and allows the
system administrator to access the server from the station.

Runtime Reboot Mode (Smart Reboot)

In this mode, RDM checks the status of all processors installed in the server.  If
there is at least one processor that is in good condition, the server automatically
reboots.  This mode applies only to system with multiple processors.  However, if
the temperatures of all processors in the system are higher than the maximum
limit, the RDM module will not reboot the system until the temperature of at least
one of the processors returns to normal.

To minimize the system down time, we
recommend that you set the RDM Work Mode
parameter in the BIOS Setup to Reboot (see
section 3.2.10 for details).  This setting enables
the server to start paging and reboot
immediately in the event of system failure.

Enabling Runtime Reboot Mode

Follow these steps to enable the Runtime Reboot mode:

1. Enter the BIOS Setup.

2. Highlight the Remote Diagnostic Configuration option.

3. Go to page 2 of the RDM Configuration menu.

4. Set the RDM Work Mode parameter to Reboot.
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After Smart reboot, the processors with very
high temperatures will be disabled.  To enable
the processors, you need to totally shutdown
the system, i.e., by unplugging all power cables
from the outlet.  When you turn on the system,
all processors become enabled again.

5. Specify the system administrator’s pager number in the System Critical Paging
Number parameter.  You may enter a maximum of three pager numbers.

6. Specify the desired setting for the Paging Times parameter.

7. Save your changes and exit the BIOS Setup.  The server automatically reboots
and runs in Runtime Reboot mode.

Runtime Remote Mode (Waiting)

In this mode, when the server hangs or fails, the RDM module starts paging.  Once
the administrator receives the paging, he or she can call to the RDM host from the
station site to establish connection.  When connection is established, the Snapshot
window appears on the screen.

Enabling Runtime Remote Mode

Follow these steps to enable the Runtime Remote mode:

1. Enter the BIOS Setup.

2. Highlight the Remote Diagnostic Configuration option.

3. Go to page 2 of the RDM Configuration menu.

4. Set the RDM Work Mode parameter to Waiting.

5. Enter a password in the Waiting Mode Password parameter.  You will use this
password to access the server from a remote site.
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6. Specify the system administrator’s pager number in the System Critical Paging
Number parameter.  You may enter a maximum of three pager numbers.

7. Specify the desired setting for the Paging Times parameter.

8. Save your changes and exit the BIOS Setup.  The server automatically reboots
and runs in Runtime Remote mode.

For remote waiting mode operations, refer to Chapter 4.

3.4 Hidden Partition Utilities in Remote Mode

What is the Hidden Partition?

The RDM hidden partition is a special partition on the primary hard disk drive
that stores the RDM utilities. This partition is pre-installed on your system. Having
this partition allows you to use the RDM utilities without having to run them from
a floppy diskette.

The RDM hidden partition also allows you to access your computer from a remote
location and run diagnostic routines.

3.4.1 RDM Utilities

The hidden partition facilitates diagnostics and execution of several useful utilities.
The following is a list of the utilities that reside in the hidden partition, along with
a description of each utility. The hidden partition tools will work with or without
Remote Console enabled.

All RDM utilities can be executed either locally
or on a remote Station through a modem.  See
"RDM Remote Mode" in section 3.3.2 for
instructions on how to establish a remote
connection.
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RDM Utility Limitations

1. Only text mode is supported.

2. BIOS INT 14h is disabled

3. BIOS INT 1Ch is used to detect if system is still alive. The running applications
cannot disable interrupts for over 5 minutes.

4. All applications must use INT 16h to get keys which a user types in.

5. DOSKEY cannot be used under Remote Console.

Acer BIOS Flash

The Acer BIOS flash utility is used to update your BIOS with a newer revision. The
utility is located in the \aflash directory. To flash your BIOS, do the following:

1. cd \aflash � .

2. Type aflash � .

Server Doctor

Limitations

The following components cannot be tested from a remote console:

1. Miscellaneous test. This tests devices such as sound cards and CD-ROM
drives. These tests cannot be checked remotely because the hardware resides
on the local server.

2. Floppy Disk test. This test requires a blank diskette to be inserted in the server
diskette drive.

3. COM2 test. This port is used for connection between the server and station.
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The Server Doctor utility is used to diagnose your server. To use Server Doctor, do
the following:

1. cd \servdr � .

2. Type servdr � .

View DMI Information

Use this tool to see detailed system BIOS information. To access this utility, do the
following:

1. cd \tools � .

2. Type dmidump � .

Check SEEPROM Information

Use this tool to check and test SEEPROM information. To access this utility, do the
following:

1. cd \tools � .

2. Type testasm � .

View SEEPROM Information

Use this tool to view SEEPROM information. To access this utility, do the
following:

1. cd \tools � .

2. Type rdmdata file.hst /r � .
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where file.hst is the filename and /r indicates that the file should be viewed in read
only mode.

Do not use the /w write option with the above
command. Doing so will destroy the SEEPROM
data.

3. Use RDM Station’s “View Snapshot File” to view the contents of the file.hst
file.

CPU BIOS Update Code

Limitations

1. This tool is only available for Pentium Pro and Pentium II CPU’s.

2. This tool can only be tested while in Local Mode.

This utility is provided by the system manufacturer. It is used to update the CPU
type in the BIOS. To use this utility, type:

1. cd \tools � .

2. cd \bu � .

3. Type checkup1 � .

The server will hang after this test. The server must be powered off, then back on,
to reboot after this test is performed.

Display Part Number and Serial Number

Use this tool to display and verify the part number and serial number of your
system (from both a local server and from a remote station):

1. cd \tools � .
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2. Type \getattoo.

EISA Configuration Utility

This utility is only applicable to the AcerAltos
servers with slots.

To run the ECU utility, do the following:

1. cd \ecu � .

2. Type cf � .

3. Follow the onscreen instructions.

Registering the RDM System

The system registration is necessary especially when troubleshooting. Important
information such as person to contact, telephone number, location and asset tag are
listed in the registration.

To register the RDM system, follow these steps:

1. Prepare a DOS bootable diskette and allow the system to boot from the
diskette.

2. After bootup, remove the DOS bootable diskette and replace it with the
WEEPROM diskette.

3. Type the command \WEEPROM.EXE. The following screen appears:
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Figure 3-1 Write SEEPROM Utility Main Menu
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4. Highlight Basic Information and press � . The following figure appears:

Figure 3-2 Basic Information Screen

5. Enter the information being asked in the appropriate text boxes.

6. Make sure that your entries are correct, then press � to return to the Main
menu.
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7. When in the Main menu, press � again to exit the utility. The following
message box appears.

Figure 3-3 Save Changes Prompt

8. Select Y to save the settings, as well as the changes.

3.4.2 TESTASM Utility

TESTASM, located in the C:\TOOLS directory, is a diagnostic program for testing
specific components used by ASM.  It analyzes the processor temperature, voltage,
serial EEPROM, I2C bus and system status.
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The following screen appears when TESTASM is executed:

TESTASM Diagnostic Program v2.00-012
Copyright (C) 1997, Acer Inc. All Rights Reserved.

A - Status Monitor
D - I2C EEPROM Dump
E - I2C Mother Board EEPROM Read/Write
S - Reset RDM
1 - Dump LM78-1 Register
B - I2C Buffer
X - Exit the program

Press one of the above keys:

Figure 3-4 TESTASM Menu

To select an option, simply press the key that corresponds to the desired option.
Valid entries are A, D, E, S, 1, B, and X.

Table 3-2 TESTASM Options

Key Option Description

A Status Monitor Checks the CPU, fan status,
system temperature, …etc.

D I2C EEPROM Dump Displays the data stored in I2C
EEPROM.

E I2C Mother Board
EEPROM Read/Write

Checks the read and write
operations of the I2C motherboard
EEPROM.

S Reset RDM RDN daughter board reset test

1 Dump LM78-1
Registers

Displays information about the
LM78-1 registers.

B I2C Buffer Displays the status of the fuse(s),
CPU, redundant power supply(ies).

X Exit Exits the program.
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3.5 How to Activate the Hidden Partition
The hidden partition is activated either via the BIOS setup or if the system crashes
while RDM is running in Runtime Remote mode.

If you install a new hard disk as your primary boot device, you will need to
reinstall the hidden partition onto this new hard disk. See “Creating a Hidden
Partition” in Chapter 2, for instructions on how to reinstall the RDM hidden
partition.
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Chapter 4  Using RDM Station
The RDM Station utility allows the system administrator to monitor the RDM-
enabled servers remotely.

4.1 Running the RDM Station Utility
In order to establish RDM connection, the station must be running the RDM
Station utility.  To run the utility, do the following:

1. Enter Windows.

2. Open the RDM Station program group.

3. From the RDM Station program group, click on the RDM icon.  The station
starts initializing COM port occupied by the modem.  The following message
displays if the initialization is successful.

Figure 4-1 COM Port Initialization Message Box

4. Click on OK.  This process is followed by the initialization of the modem.  The
following message appears if the modem initialization is successful.
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Figure 4-2 Modem Initialization Message Box

5. Click on OK.  The screen displays the RDM Station utility window.

Figure 4-3 RDM Station Utility Window

RDM Station is functional now.  As long as the server has been booted into
Runtime Remote mode, the RDM Station is capable of accessing the server in case
of server failure.
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4.2 The Utility Menus

The File Menu

The File menu contains the following commands:

6DYH 6HWWLQJV Saves the Communication
configuration file with a new name.

9LHZ 6QDSVKRW )LOH« Displays a saved Snapshot file.  The
snapshot files is automatically created
when the server crashes.

([LW Closes the RDM Station utility.

The Edit Menu

The Edit menu contains the following commands:

&OHDU :LQGRZ Clears the utility screen.

6DYH /RJ )LOH Saves the current screen as .LOG file.
This is very useful especially if you are
debugging or troubleshooting.  By
default, this option is grayed out, i.e.,
disabled.  This option is only available
while you are connected to a remote
server.

6WRS 6DYLQJ /RJ Disables the Saving Log File function.
By default, this option is grayed out,
i.e., disabled.
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The View Menu

The View menu contains the following options:

7RROEDU Shows or hides the utility Toolbar.

6WDWXV EDU Shows or hides the status bar, i.e., the
bar located at the bottom of the utility
window.

The Settings Menu

The Settings menu contains the following options:

&RPPXQLFDWLRQ Lets you configure the RDM Station
function.

)RQW Allows you to change your font
properties.

The Phone Menu

The Phone menu contains the following commands:

'LDO WR 5'0 +RVW Dials the number specified in the Phone
No. to Dial box under the Settings
menu.  This lets the station establish
connection to the server.  Once
connection is established, this option
becomes disabled.

+DQJ 8S Disables the telephone connection.  By
default, this option is grayed out, i.e.,
disabled.  Once remote connection is
established, this option becomes
enabled.
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The Transfer Menu

The Transfer menu enables the station and the server to send and receive files.

6HQG )LOH Enables the station to send files to the
server.

5HFHLYH )LOH Enables the station to receive files from
the server.

By default, these options are grayed out, i.e.,
disabled.  Once remote connection is
established and server boots to hidden
partition, the options become enabled

The RDM Agent Menu

The RDM Agent menu contains the following commands:

,QVWDOO 765 Allows you to install Terminate and
Stay Resident (TSR) program.  This
program is stored in RAM so that they
can be easily activated.  This option is
needed only if the station is
communicating with an RDM v1.x
agent.

8QLQVWDOO 765 Removes or uninstalls the TSR program
from the memory.  This option is
needed only if the station is
communicating with an RDM v1.x
agent.

5HIUHVK 6FUHHQ Updates the current screen.

5'0 7DON Runs the Talk utility.  This utility allows
the users located at station and agent
sites to communicate online.
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5HERRW $JHQW Allows you to reboot the server from
the station site in either of two modes:

Disconnect
Reboots the server after first disabling
the Remote Console BIOS setting.

Keep Monitoring
Reboots the server into normal mode,
reestablishing the connection after
rebooting.

$ERXW $JHQW Displays the copyright and version
number of the server’s remote console
driver.

By default, all options are grayed out, i.e.,
disabled.  Once remote connection is
established and the server boots to hidden
partition, the options become enabled

The Help Menu

The Help menu contains the following commands:

,QGH[ Displays the Help index.  The index
helps you to find the information that
you want easily.

8VLQJ +HOS Opens the RDM online help.

$ERXW 5'0 Displays the copyright, version number
and release date of the RDM Station
utility.
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4.3 The Toolbar Buttons

Saves the configuration as .STN file.

Clears the screen.

Dials the server phone number.  This
button becomes gray or disabled after
remote connection is established.

Saves the current screen as .LOG file.
This is very useful especially if you are
debugging or troubleshooting.  By
default, this button is grayed out, i.e.,
disabled.  Once remote connection is
established, it becomes enabled.

Disables the Saving Log File function.
By default, this button is grayed out,
i.e., disabled.  Once you select the Save
Log File command or , it becomes
enabled.

Displays the copyright, version number
and release date of the RDM Station
utility.

Clicking this button changes the cursor
to an arrow with a question mark ( )
form.  This indicates that the RDM Help
has been invoked.  Click on the button
where you need help on a particular
subject.
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4.4 Configuring RDM Station
To configure RDM, follow these steps:

1. Select Settings from the menu bar.

2. Select the Communication command.  The Communication Settings dialog
box appears.

Figure 4-4 Communication Settings Dialog Box

3. Enter the server phone number in the Phone No. to Dial box.

4. In the Phone No. to Dial Back box, enter the station phone number that the
server will dial when it attempts to call back the station.

5. Enter the correct password in the RDM password box.  The password must be
the same as the one specified in the Waiting Mode Password BIOS parameter.
See Chapter 3 for more details on RDM BIOS.

6. Set the desired speaker volume in the Speaker Volume box.

7. Disable/enable the Auto-answer feature.
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8. If the modem currently in use requires a special command for initialization,
specify the command in the Initialize Command box.  We recommend you use
the default modem initialization command.  To do this, simply click on the
Load Default button.

If the modem initialization fails, check your
modem’s manual for the proper initialization
command and enter it in the Initialize
Command Box.

9. Click on the down arrow of the COM Port box and select the COM port that
you want to assign for the modem function.

Only the COM1 and COM2 ports are
supported by the RDM Station.

10. Click on the down arrow of the Baud Rate box and select the baud rate that
you want to support.  The default setting is 57600.

11. Click on the down arrow of the Parity Check box and select the number of
parity to check to ensure data accuracy.

12. Click on the down arrow of the Data Bits box and select the data length for the
COM port.

13. Click on the down arrow of the Stop Bits box and select a stop bit for the COM
port.

14. If you want to enable the Local Echo feature, click on the Local Echo box.  This
feature enables the monitor to display all the messages entered and sent by the
server and the station when Talk mode is enabled.
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We suggest that you leave the other
parameters to their default settings.  

15. Click on OK after entering the desired settings.  The Save Configuration dialog
box appears.  Follow the instructions in the next subsection to save the
configuration.

4.4.1 Setting the Font Properties

You can select the font that you want to appear on the RDM Station window for
displaying text.

To select a font, do the following:

1. From the menu bar, select the Settings menu.

2. Select the Font command.  The Font dialog box appears.

3. From the Font box, select the desired font type.

4. From the Font Style box, select the desired font style.

5. From the Size box, select the desired font size.

6. After making your selections, the desired character appears in the Sample box.
Verify your settings, click on OK.

4.4.2 Saving the Configuration

You can save the your RDM utility configuration as a file with .STN extension.
This enables you to retrieve your previous configuration in case you have decided
to cancel the modifications that you have done.
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To save, do the following steps:

1. Do either of the following:

• Click on File and select Save Settings option.

• From the Toolbar, click on the Save button ( ).

2. The Save Configuration File dialog box appears.

Figure 4-5 Save Configuration File Dialog Box

3. Enter a filename in the File Name box.  Then specify the path where you want
to save the .STN file in the Drive and Directories boxes.

4. Click on OK to save the configuration to the specified filename or click on
Cancel to disregard the entries and quit the Save Configuration File dialog box.

You may rename the configuration file by
following the above steps and specifying a
different filename.
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4.4.3 Loading a Previous Configuration

If you want to load the previously saved configuration, do the following:

1. Select Settings from the menu bar.

2. Select the Communication command.  The Communication Settings dialog
box appears.

3. Click on the Browse button.  The Open Configuration File dialog box appears.

4. Select the configuration file that you want to open from the list in the
Directories box.

5. After making your selection, click on OK.
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4.5 RDM Remote Mode Operation
This operation requires that the RDM-enabled server be set to Remote Console
[Enabled] in the RDM BIOS.  See Chapter 3 for instructions on setting the RDM
BIOS.

After rebooting the server, the RDM module will automatically establish
connection with the RDM Station.  Once the connection is established, the
following screen appears on both the server and the station.

BIOS v2.1                                                   

0032384 KB Memory Good
RDM Module Detected
Remote Console Dialing Out.  Please Wait…
Connect Successfully

Check Point: 88

Enter Setup, Remote Site press ! key, Local Site press CTRL_ALT_ESC

ACR45E00-Io8-9709701-R01-B0-T3.RC311

You can access all RDM utilities from the RDM Station.  From the station you can
do either of the following:

• Press   to view the server BIOS Setup.  For details on BIOS Setup, refer
to the system’s documentation.

• Boot to hidden partition.

Remote Console supports VGA text mode only.
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4.5.1 Exiting from Remote Mode

If you want to resume the system to normal operation, you need to exit from
Remote mode.

To exit from Remote mode, do the following steps:

1. Run the RDM Station program.  See section 4.1 for details.

2. From the menu bar, select Agent.

3. Select the Reboot Agent command.  The Confirm RDM Host Reboot dialog
box appears.

Figure 4-6 Confirm RDM Host Reboot Dialog Box

4. Click on Disconnect.  The system automatically reboots, terminates connection
and returns back to normal operating mode.

If you click on the Keep Monitoring option,
the server reboots without disabling the
connection with the remote station.
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4.6 Remotely Accessing the Server
If the RDM enabled server has been set to the Runtime Remote mode, the RDM
module pages the system administrator after the server hangs or fails.  The system
administrator can then call the RDM server from the remote RDM Station, to:

• Get a snapshot

• Get the current server status

• Turn off the server

• Reboot the server

4.6.1 Connecting to the Server

Before you proceed, make sure that RDM is
activated and running in Runtime Remote
mode.

To establish connection with the server from the RDM Station, do the following
steps:

1. From the menu bar, select the Settings menu.  The Communication Settings
dialog box appears on screen.

2. Check your Phone No. To Dial setting.  If it is not correct, enter the correct
server phone number.

3. Check your Phone No. to Dial Back setting.  If it is not correct, enter the station
phone number that the server must dial when it attempts to call back the
station.

4. Enter the RDM password box.  The password must match the password
entered in the Waiting Mode Password BIOS parameter.  See Chapter 3 for
more details on RDM BIOS.
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5. When prompted to save the file, enter a filename if you wish to save the
settings.  Then click on OK.

6. The RDM Station utility window reappears on the screen.  Select the Phone
menu.

7. Select the Dial to RDM Host command to establish connection.  The station
dials the server number.  When the call is successful, the RDM module verifies
the entered password and the following message box appears:

Figure 4-7 Dialing Message Box

If the password matches the server’s password for remote connection, the
System Snapshot window appears.  The System Snapshot window displays the
current server information.
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4.6.2 Server Snapshot

Once connection is established from RDM Station to the server, the server status is
shown in the snapshot window:

Figure 4-8 System Snapshot Window

Snapshot Window Button Functions

Get Snap Shot Re-displays the System Snapshot window
(see Figure 4-8).  This window contains
important information about the server.
For more details on the contents of
Snapshot window, see Appendix C.

Get Current Status Displays the updated information related
to the server, such as system power, CPU
status, system voltage, fuse, and chassis
front door statuses.
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If the server is turned off by selecting
the Turn Off button from the
Snapshot window, some of the
information in the Get Current Status
display will be deleted.  Only the
system Power, CPU, and chassis
front door statuses will remain on the
display.

Keep Waiting Cuts off the existing connection with the
server and allows the server to remain
available, waiting for other stations to dial
in to make connection.

Turn Off System Turns off the server power.  If you click
this button, the following message box
appears:

Figure 4-9 System Turned Off Message Box

Reboot Displays the Reboot Options dialog box
and reboots the server according to the
specified reboot options.

Figure 4-10 Reboot Options Dialog Box
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The available options are:.

Reboot Types:

Smart When selected, RDM
checks the status of all
processors installed in the
server.  If there is at least
one processor that is in
good condition, the
system automatically
reboots.  After reboot, the
following message box
appears:

Figure 4-11 Smart Reboot Message
Box

If all processors are in bad
condition, a message informing you
of the condition of the processor(s)
and asking if you still want to
continue to reboot the system
appears.

Click on Yes to “force” reboot the server.
The system will use all the processors
installed in it to reboot.

Normal When selected, RDM checks the
status of all the processors  installed
in the server.  If all processors are in



RDM User’s Guide4-20

good condition, the system
automatically reboots and shows
the following message:

Figure 4-12 Successful Normal Reboot
Message Box

If any of the processors is in bad
condition, a message informing you
of the condition of the processor(s)
appears.

Figure 4-13 Normal Reboot Fail
Message Box

Click on OK.  Another message box
appears, asking if you want to force
a reboot.

Click on Yes to “force” reboot the
server.  The system will use all the
processors installed in it to reboot.
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The following Remote Console options are available:

Enabled Maintains remote connection after
server reboots and allows the
remote site to fully control the
server.

Call Back When selected, remote connection
cuts off before the server reboots.
After reboot, the server dials back to
the station to resume connection.
This option is recommended if you
want to pass the connection charges
to the server.

After verifying your settings, click on OK.  The server reboots according to
your specified settings.

4.6.3 Saving a Log File

If you want to save the current screen, perform the following steps:

1. Do either of the following:

• Click on the Log button ( ) from the Toolbar.

• Click on the Edit menu and select Save Log File command.

The Save Log File dialog box appears.
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Figure 4-14 Save Log File Dialog Box

2. Enter a filename in the File Name box.  Then specify the path where you want
to save the .LOG file in the Drive and Directories boxes.

3. Click on OK to save the current screen specified filename or click on Cancel to
disregard the entries and quit the Save Log File dialog box.

The Save Log File function differs for RDM
v1.x and RDM v3.0/v3.01.  In RDM v1.x, all
screens that appear from the time you clicked
the Save Log File button ( ) will be saved to
the specified filename, until you click on the
Disable Save Log File button ( ).  

In RDM v3.0/v3.01, only the current screen on
display when you clicked the Save Log File
button ( ) will be saved.  To save the
following screens, you must click the Save Log
File button after each screen.  All saved
screen will be appended to the specified Log
filename.
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4.6.4 Viewing a Snapshot File

To view a previously saved Snapshot file, do the following steps:

1. From the menu bar, select the File menu.

2. Select the View Snapshot File command.  The Open system Snapshot File
dialog box appears.

3. From the Folders box, select the path where the desired Snapshot file is
located.

4. From the File Name list box, select the desired Snapshot file.

5. After making your selection, click on OK.  The screen displays the selected
Snapshot file.

4.6.5 Sending Files

Before you send files, make sure that the
agent is in DOS command mode and that the
files to be transferred are stored in the local
hard disk.

To send files to the server, do the following:

1. From the menu bar, select the Transfer menu.

2. Select the Send File command.  The Open dialog box appears.
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Figure 4-15 Open File Dialog Box

3. Choose the file(s) that you want to send then click on OK.  You may choose as
many files as you want.  The Remote Directory Path dialog box appears.

4. Enter the directory in the server where you want to copy the selected files in
the Full path name of remote directory entry box.

5. After verifying the entered path, click on OK.  The File Transfer Status dialog
box appears.

Figure 4-16 File Transfer Status Dialog Box

6. To stop the sending operation of the file that the station is currently
transferring, click on the Terminate button.  To stop the sending of all the
selected files, click on the Terminate All button.
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 If the file(s) already exist, a message box prompting you to confirm the
replacement of the files will appear.  Click on Yes to confirm the replacement
of the file that is currently being transferred.  Click on Yes to All to confirm the
replacement of all the common files.  Click on No if you do not want to replace
the file.

 Notice that the OK button remains grayed until the file transfer is completed.
The Cancel button becomes grayed when file transfer fails.

To close the Transfer Status dialog box, click on OK.  To disregard the
operation that has been performed previously, click on Cancel.

The maximum file size that can be
transferred is 18 MB.

4.6.6 Receiving Files

Before you receive files, make sure that the
agent is in DOS command mode.

To receive files from the server, do the following:

1. From the menu bar, select the Transfer menu.

2. Select the Receive File command.  The Receive File Name dialog box appears.
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Figure 4-17 Receive File Name Dialog Box

3. Enter the path where the files are located in the Full path name of the remote
file entry box then click on OK.  The File Receive Status dialog box appears.

Figure 4-18 File Receive Status Dialog Box

4. Notice that the OK button remains grayed until the transfer of file(s) is
completed.  To stop the transfer of file(s) or to disregard the operation that has
been performed previously, click on Cancel.

 If the file(s) already exist, a message box prompting you to confirm the
replacement of the files will appear.  Click on Yes to confirm the replacement
of the file that is currently being transferred.  Click on Yes to All to confirm the
replacement of all the common files.  Click on No if you do not want to replace
the file.

5. When the file transfer is finished, click on the OK button to close the Receive
Status dialog box.
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The maximum file size that can be
transferred is 18 MB.

4.6.7 Running the Talk Utility

The Talk utility allows the user at the station site to directly communicate with the
user at the server site via PC.  User at both sites can send messages by simply
typing in the text.

To run the Talk utility, do the following:

1. From the menu bar, select the Agent menu.

2. Select the RDM Talk command.  The Talk Utility screen appears both on the
server site and on the local site monitors.

Figure 4-19 Talk Utility Screen
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3. Type in the messages that you want to send.  The messages from the server site
appears on the upper portion of the screen, while the messages from the
station site appears at the lower portion

4. To exit the utility, simply press  .

4.6.8 Rebooting the Server

To reboot the server, do the following:

1. From the menu bar, click on the Agent menu and select the Reboot Agent
command.  The Confirm RDM Host Reboot dialog box appears.

Figure 4-20 Confirm RDM Host Reboot Dialog Box

2. Click on the Disconnect button to disable RDM and reboot the server to
normal mode.  Click on the Keep Monitoring button to simply reboot the
server.  If you suddenly decided not to reboot the server, click on Cancel.

3. After making your choice, the dialog box disappears from the screen and the
selected reboot option is performed.
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Chapter 5  Troubleshooting
This chapter lists the common problems that you may encounter during RDM
operation, followed by the possible corrective action(s).

5.1 RDM Agent Troubleshooting
1. The loopback test failed after running RDMLP.

 Check the RDM module and make sure that it is properly plugged into its
socket.

2. The RDM LED indicator is not lit while running RDM in either Local or
Remote mode.

 The LED indicator lights up in Runtime mode only.  After the server reboots
itself, the LED indicator will turn off.   The Runtime mode is active only during
a server failure.

3. The RDM Work Mode parameter is grayed out.

 Check the RDM module and make sure that it is properly plugged into its
socket.

4. The message “No RDM Hidden Partition” appears.

 Do the following:

 i. Enter the BIOS Setup.

 ii. Set the Hidden Partition to Enabled.
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iii.  Exit the BIOS Setup and save your changes.

iv.  Make sure that you have created the hidden partition.  Refer to section
3.2.3 for instructions.  In case you need to recreate the RDM hidden
partition, do not forget to back up all important files before you proceed.
Creating the RDM partition destroys all data on the hard disk due to the
requirement that the RDM hidden partition must be the first partition on
the primary hard disk.

5.1.1 Hidden Partition Troubleshooting

If there are bad sectors or other damages in the hidden partition, do the following
steps:

1. Insert a bootable diskette into the diskette drive.

2. Enter the BIOS Setup and set the Hidden Partition parameter in the RDM BIOS
to Enabled.

3. After the system boot from the diskette drive, use the Disk Repair tool to
troubleshoot the partition.
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5.1.2 BIOS Messages

The following table lists the BIOS status and error messages that you might
encounter when using RDM.

Table 5-1 BIOS Status and Error Messages

BIOS Message Description

RDM Module Detected BIOS detected an RDM module in the
system.

RDM SEEPROM Data
Unavailable

RDM data in SEEPROM is not correct.
You may have to contact your vendor to
resolve this problem.

RDM Enabled But
Modem Not Ready

RDM Work Mode is set to Reboot or
Waiting; however there is no modem
available for the RDM module.  Check if
there is a modem connected to serial
port 2.  Make sure that it is ON.

RDM Dialing Out.
Please Wait…

Remote Console function has been
enabled.  BIOS will dial out to connect
to the RDM Station.  This process will
take for a couple of minutes.

Connect Fail:  Serial 2
Disabled

Serial 2 is disabled.  Enter the BIOS
Setup, select the System Security
option, and set an I/O port for serial 2.

Connect Fail:  Modem
Off

Modem is OFF.  Check if modem is
connected to serial 2.  Make sure that it
is ON.

Connect Fail:  Modem
Initial Command Fail

The default modem initial command
failed.  Consult your modem’s manual.
The BIOS default command is
AT&F1&C1V0X0M1L2S7=120

Connect Fail:  No Dial
Tone

Modem cannot detect a dial tone.  Make
sure that the telephone is working
properly.
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Table 5-1 BIOS Status and Error Messages  (continued)

BIOS Message Description

Connect Fail:  Line Busy RDM Station is busy now.  Wait for a
few minutes, then try reconnecting.

Connect Fail:  No
Answer

No response from the RDM Station.
Make sure that the RDM Station phone
number is correct.

Connect Fail:  No
Telephone to Dial

RDM Console is enabled but no RDM
Station phone number is set.  Enter the
BIOS Setup, select the Remote
Diagnostic Configuration option, and
enter the station number in the Remote
Console parameter.

Connect Fail:  User Stop
Dialing Out

The  key is pressed during the RDM
dialing out process.  Do not press 
while RDM is dialing out unless you
want to stop the connection process.

No RDM Hidden
Partition

RDM hidden partition is enabled but no
hidden partition created in the hard disk.
Enter BIOS Setup, select the Remote
Diagnostic Configuration option, and
disable the Hidden Partition parameter.
This returns your system to its normal
booting process.  For more details on
Hidden Partition, see Chapter 3.

5.1.3 Remote Console Limitations

Most functions can be accessed using a remote console.  The following list shows
the exceptions, i.e., the limitations of using the remote console.

• PMU (power management unit) is disabled

• Supports Text mode only

• BIOS int 14h is disabled
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• BIOS INT 1Ch is used to detect the server status.  If the server fails, the INT
1Ch stops updating the hardware timer.  If this condition remains for 5
minutes (i.e., the BIOS default timer timeout), the server automatically reboots,
reconnects and reassigns the INT 1Ch for the same function.  INT 1Ch cannot
be disabled.

• All applications must use INT 16h to determine the keys or the characters
entered by the user from the station site.

• Cannot run DOSKEY.EXE

• Stops functioning after the server reboots into its installed operating system.

5.1.4 Server Doctor

The following Server Doctor tests cannot be performed remotely, for the reason
explained with each test:

Miscellaneous Test

The Miscellaneous Test tests such devices as sound boards, CD-ROM drives, etc.
These tests cannot be checked from a remote terminal because the hardware
resides on the local terminal.

Floppy Disk Test

The Floppy Disk test requires a blank diskette to be inserted in the diskette drive.
Since this requires human intervention to insert a blank diskette, it may not be
possible to run this test.

COM2 Test

COM2 cannot be used remotely because the modem uses COM2 for
communication.
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5.2 RDM Station Troubleshooting
In general, if you have display problems when running a utility from remote
mode, it’s a good idea to check  if you must first run the “install TSR” option.  See
the “RDM Utilities” section.

Problem

No display when I run ECU from a remote station.

Solution

See the “EISA Configuration Utility” section.

Problem

No display when I run Server Doctor from a remote station.

Solution

See the “Server Doctor” section.
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Appendix A RDM Module Test 
Utilities

This appendix gives instructions on how to run the RDM module test utilities.
This will help you verify if the module is working properly.

  A.1 Testing Utilities
The RDM is equipped with two module testing utilities:

RDMLP This utility is used to verify that the RDM
hardware is working properly.  For details,
see section A.2.

RDMDRV This utility simulates a server crash,
allowing you to verify that the RDM work
mode is running properly.  For details, see
section A.3.

  A.2 Hardware Check

Before you proceed with the hardware test,
make sure that the modem is connected to
COM2 port.
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Do the following to verify that the hardware is installed and running properly:

1. Prepare a bootable RDMLP diskette and copy RDMLP.EXE and RDM30T.EXE
files.

2. Boot the server using the RDMLP bootable diskette.

3. Turn on the modem.

4. Under DOS, type:

RDMLP/C  

5. Use this utility to check the RDM module and COM port 2 (make sure that the
modem is connected to COM2).

 When you run this utility, the following events will take place during the test.

 i. Test heartbeat protocol.

 ii. Then 10 seconds later, system will reboot.

 iii. After system reboot, RDM module will turn off the system and test certain 
components.

 iv. About 5 seconds, RDM module will switch the system on again.

 v. System will boot to Drive A.

6. After the test completes, the screen should display either a PASS message or a
FAIL message with a beep sound.

If the test fails, check the RDM module
installation.  See Chapter 2 for instructions
on how to install the RDM module.  
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  A.3 Simulating a Server Failure
You need to run a test that simulates a server failure in order to determine whether
the Runtime Remote mode is functioning properly.

Do the following steps:

1. Insert a bootable diskette that contains the RDMDRV.EXE file in the diskette
drive and boot the server.

2. Enable the Runtime mode.  Refer to section 3.3.2.

3. After the system boots, at the DOS prompt, type:

RDMDRV  

The following message appears on the screen:

RDM daughter board test program v3.0

RDM BIOS version:  3.00

RDM daughter board firmware version:  3.0

RDM module will be active after 30 seconds.

The server is now simulating a failure.  Check if the RDM LED indicator is lighted.

Once the LED lights up, RDM starts dialing the specified pager numbers.  When
paging is successfully completed, you can now call the server from the station to
establish connection.  Refer to section 4.6.1 for detailed instructions.
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Appendix B SCO OpenServer and 
the RDM Partition

This appendix describes how to do a fresh installation of SCO OpenServer while
preserving the RDM hidden partition.1

B.1 SCO OpenServer 5 Installation and RDM
The default option for Hard Disk Setup is Unix only: Bad blocking 0 FF.
Do NOT accept this default option.  This will overwrite the RDM partition.

The RDM hidden partition is needed by RDM
for remotely diagnosing your server.

1. Boot the computer with the SCO OpenServer boot floppy and the SCO
OpenServer CD-ROM loaded in their respective drives.

2. Follow the onscreen prompts in the SCO installation until you reach the Hard
Disk Setup entry.

3. Choose Interactive fdisk/divvy.

                                                          
1 On AcerAltos servers that came with the RDM hidden partition pre-installed.
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4. Choose either Use the Rest of the Disk for Unix for allocating the remaining
space to Unix, or Display Partition Table to customize it.

Steps 2 through 4 above must be performed
in order to preserve the RDM partition that
was pre-installed on your computer.

�

If you are using SCO OSR 5 Easy Install in
Acer Startup, it will detect and preserve the
RDM partition automatically.  If you are doing
a manual installation, perform steps 2- 4
above to ensure that you do not accidentally
overwrite your RDM hidden partition.
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Appendix C  Snapshot Window
Information

This appendix describes the information displayed on the Snapshot
window.

1.  To display the Snapshot window, follow the
steps listed in section 4.6 - Remotely Accessing
the Server.

2. To view the complete information on the
Snapshot window, use the horizontal and
vertical scroll bars.

There are four types of information shown on the Snapshot window.

• Basic DMI Information

• ASM Health Log

• System Failure Status

• RDM Basic Information

  C.1 Basic DMI Information

The Basic DMI
1

 Information lists the basic information about the
server.  These data are very useful for the remote service engineers
to fully understand the server.

                                                          
1    DMI:  Desktop Management Interface
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The following is a sample of the Basic DMI Information list.
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  C.2 ASM Health Log
The ASM Health Log contains a list of system failure events
detected by the ASM agent and their occurrence time in GMT

2

.
These data are recorded in the SEEPROM chip

The following is a sample of the ASM Health Log.

  
C.3 System Failure Status
The System Failure Status contains hardware related information
recorded by RDM when system failure occurred.

                                                          
2    GMT:  Greenwich Meridian Time
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A sample of the System Failure Status display appears below.
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1.  The Latest, 2nd, 3rd, 4th, and 5th  last Failure
Time parameters appear only if the RDM
daughterboard installed in the system is v3.01.

2.  The Issue IERR# specifies the occurrence of
internal error in CPU; the Issue Thermtrip#
specifies that the CPU temperature has
exceeded its limit (i.e., 135°C).

3.  The System Voltage Status specifies system
information at expected voltage and at actual
measured voltage.

  C.4 RDM Basic Information
The RDM Basic Information includes the RDM Work Mode related
information, such as the dialer phone number, remote console
phone number, pager number(s), and password.  These data help
the remote service engineers understand the RDM operation.

A sample of the RDM Basic Information list appears below.
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